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Section 4 Scheduling with Calendar
All graphics related to Microsoft in this book is in compliance with Microsoft guidelines and thus permitted by Microsoft.

Objectives
At the completion of this lesson you will be able to:
•

Navigating in Calendar

•

Making and Moving Appointments

•

Managing Appointments

Topics
Navigating in Calendar
Viewing a Day, a Week, or a Month
Using the Date Navigator
Viewing a Range of Dates, Several Weeks, and Discontiguous Days
Showing Two Time Zones
Making and Moving Appointments
Selecting an Appointment and Modifying the Date in Day View
Modifying the Date in Week View
Changing the Time of an Appointment
Managing Appointments
Editing Recurring Appointments
Creating Tentative Appointments
Inserting All Day Events
Deleting Appointments
Restoring Deleted Appointments
Assignment
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Navigating in Calendar
In the Calendar folder, you can schedule appointments and review your tasks. An appointment is a scheduled activity that
does not involve anyone else. A task is an activity you must perform and track to completion.
To manage your time effectively, you must be able to move easily from one date to another within your Outlook Calendar
and to display each date in the desired view. The Calendar toolbar offers quick access to various Calendar views. The Date
Navigator, which looks like a monthly calendar, helps you speedily move from one week or month to another. You can
even show two time zones, which helps you when traveling or when working with someone at an office in another time
zone. The TaskPad holds your to do list. Figure 4‑1 shows the Calendar screen elements.

Figure 4‑6 : The Calendar Screen Elements
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Viewing a Day, a Week, or a Month
In the Calendar, you can display your appointments by Day, Week, or Month view. You can also choose to filter the Current
View. Table 2‑5summarizes the built-in Current view filters.
Name

Function

Day/Week/Month

Shows the Calendar as an appointment book. Displays the
date(s) selected on the Date Navigator.

Active Appointments

Lists all active appointments. You can sort appointments by
Subject, Start Date, End Date, and so forth.

Events

Lists all active holidays and events.

Annual Events

Lists active annual events only.

Recurring Appointments

Lists recurring appointments only.

By Category

Groups active appointments by category.
Table 4‑10: The Calendar Current View Filters

On the toolbar, the context-sensitive Calendar buttons provide you with a quick means to change views and to return
to today’s date. Some of these toolbar buttons are visible only when you maximize Outlook. Table 4‑11 summarizes the
Calendar toolbar buttons and their functions.
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Name

Function

New Appointment

Opens the New Appointment window so that you can create
an appointment. The drop-down arrow gives you access to
the New windows for the other Outlook features.

Print

Allows you to print your Calendar

Delete

Deletes an appointment from your calendar

Categorize

Allows you to setup colour categories for your different
appointments

Group Schedules

Displays the group schedules associated with this calendar

Today Button

Takes you to the current date

Search Address
Book

Allows you to search for a particular contact in your address
book

Table 4‑11: The Calendar Toolbar Buttons

Method
To view a day, a week, or a month:
1. On the toolbar, click the button for the view you want. Figure 4-2

Figure 4-2: Change the calendar view
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Exercise
In the following exercise, you will view a day, a week, and a month.
1.

Open the Calendar folder

The Calendar for today, the Date Navigator,
and the TaskPad appear in Day/Week/
Month view.

2.

On the toolbar, click the
Week button

The Calendar changes to Week view.

3.

On the toolbar, click the
Month button

The Calendar changes to Month view.
The Date Navigator and the TaskPad are
hidden.

4.

On the scroll bar, click the top scroll arrow
once

The Month view starts and ends one week
earlier.

5.

On the scroll bar, drag the scroll box up
about ¼ inch slowly

As you drag, a box that gives you the
starting date for the five-week period that
would appear when you release the pointer
appears, with the date changing as you
continue to drag.

6.

On the toolbar, click the Go to
Today button

The Calendar continues to appear in its
current view, but it changes the time period
displayed to include the current day.

7.

On the toolbar, click the
Day button

The Calendar changes to Day view, showing
today’s date. The Date Navigator and the
TaskPad reappear.

Using the Date Navigator
The Date Navigator, shown in Figure 4‑3, is not only a monthly calendar but gives you quick access to any date you want.
You might have one or two months displayed in your Date Navigator, depending on your screen resolution. By adjusting
the pane size, you can expand the Date Navigator to display more months. You adjust the pane size using the doubleheaded arrow mouse pointer, shown in Figure 4‑.
When the Calendar opens, the Date Navigator highlights today’s date (December 30, 2001, as shown). It always displays
today’s date with a box around it so you can find it easily. And it displays dates on which you have scheduled appointments
in bold.

Download free eBooks at bookboon.com

14

Outlook 2007: Part II

Scheduling with Calendar

Figure 4‑3: The Date Navigator

Figure 4‑4: The Double-Headed Arrow Mouse Pointer

Method
To view appointments for a day during the current month:
1. On the Date Navigator, click the desired date.
To adjust pane size to show a different number of months in the Date Navigator:
1. Position the mouse pointer over the border between the panes you want to adjust.
2. When the mouse pointer becomes the double-headed arrow mouse pointer, drag the border to the desired
position.
To view appointments in another month:
1. Click the One Month Back arrow once for each previous month or the One Month Forward arrow once for
each future month.or
2. Click and hold the month label, and then,on the pop-up month list, drag the mouse pointer to the desired
month.
3. Click the desired date.
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Exercise
In the following exercise, you will use the Date Navigator to view dates in your Calendar.
1.

On the Date Navigator, click tomorrow’s
date

The Calendar for tomorrow appears.

2.

On the Date Navigator, click the One
Month Forward arrow

Next month’s Date Navigator appears. The
Calendar for the date you selected appears.

3.

On the Date Navigator, click the 25th of
the displayed month

The Calendar for the 25th of the displayed
month appears.

4.

On the Date Navigator, click the One
Month Forward arrow two times

The Date Navigator for three months from
now appears. The Calendar for the 25th
of the month three months from today
appears.

5.

Click and hold the month label

The pop-up month list appears.

6.

Drag the mouse pointer to the current
month

This month’s Date Navigator appears.
The Calendar for the 25th of this month
appears.

7.

On the toolbar, click the Go to Today
button

The Calendar for today appears.

8.

Position the mouse pointer over the
border that separates the Calendar from
the Date Navigator

The mouse pointer becomes the doubleheaded arrow mouse pointer.

9.

Drag the border to the left

The border does not appear to move;
however, a vertical line that indicates that
you can view one more month in the Date
Navigator appears while you are dragging.
Once you release the mouse button, a
calendar for an additional month appears
in the Date Navigator.

10.

On the Date Navigator, click any date next
month

The Calendar for the date you selected
appears.

11.

Drag the vertical border back to the right

One column of calendars disappears in the
Date Navigator.

12.

Click the Go to Today toolbar button

The Calendar for today appears.
-

Viewing a Range of Dates, Several Weeks, and Discontiguous Days
You can also use the Date Navigator to view selected days, such as a five-day work week, the next three Tuesdays, three
weeks, or whatever days you like. If the days are contiguous, you can drag across them to display them. If they are
discontinuous, you select the days by holding Ctrl and clicking the desired dates, just as you would select multiple files
in Microsoft Explorer.

Method
To view a range of dates:
Download free eBooks at bookboon.com
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1. On the Date Navigator, drag across the dates.
To view several weeks:
1. Position the mouse pointer near the left edge of the Date Navigator.
2. When the pointer changes from pointing left to pointing right, drag the pointer along the left edge of the
Date Navigator for the desired weeks.
To view discontinuous days:
1. Press and hold Ctrl
2. On the Date Navigator, click each date you want to view.
3. Release Ctrl

Exercise
In the following exercise, you will view a range of dates, three weeks, and discontinuous days.
1.

On the Date Navigator, drag from today’s
date through the next two days

Today, tomorrow, and the next day appear
on your Calendar.

2.

Position the mouse pointer near the left
edge of the Date Navigator

The pointer changes to an arrow pointing
right.

3.

Drag the pointer along the left edge of
the Date Navigator for the second and
third full weeks of this month

The second and third full weeks of this
month appear on your Calendar.

4.

On the Date Navigator, click today’s date

Today’s date is selected and appears on
your Calendar.

5.

Press and hold Ctrl

6.

On the Date Navigator, click the date one
week from today

7.

Release Ctrl

8.

On the Date Navigator, click today’s date

Today’s date and the date one week from
today appear on your Calendar.

Only today’s date appears on your
Calendar.

Showing Two Time Zones
When you work regularly with an office in another time zone, you might find it helpful to display that office’s time zone
as well as your own when displaying the Calendar. This can help you plan phone calls for the right time of day. You set
the time zone display in the Time Zone dialog box, shown in Figure 4‑5.
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Figure 4‑5: The Time Zone Dialog Box

Method
To show two time zones:
1. In the Calendar, from the Tools menu, choose Options.
2. In the Options dialog box, click the Calendar Options button, then click the Time Zone… button.
3. In the Time Zone dialog box, in the Current time zone area, in the Label text box, type a short name for the
current time zone.
4. Select the Show an additional time zone check box.
5. In the additional time zone area, in the Label text box, type a short name for the second time zone.
6. In the Time drop-down list, select a time zone.
7. If that time zone uses daylight savings time during the spring and summer, select the Adjust for daylight
saving time check box.
8. Choose OK.
9. Choose OK.
10. In the Options dialog box, choose OK.
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Note: To change your current time zone to the second time zone, in the Time Zone
dialog box, choose Swap Time Zones. This, however, affects all times displayed in all
your Windows-based programs, not just the time displayed in Outlook.

Exercise
In the following exercise, you will show two time zones.
1.

From the Tools menu, choose Options

The Options dialog box appears.

2.

In the Options dialog box, click the
Calendar Options button, then click the
Time Zone… button.

The Time Zone dialog box appears.

3.

In the Current time zone area, in the
Label text box, type a short name for
your time zone

4.

Select the Show an additional time zone
check box

5.

If necessary, select the text in the Label
text box, and then type a short name for
the time zone directly to the east of your
current time zone

6.

In the Time drop-down list, select the
time zone directly to the east of your
current time zone (the next earlier time
in the drop-down list)

7.

If necessary, select the Adjust for daylight
saving time check box

8.

Choose OK

9.

Choose OK

The Options dialog box reappears.

10.

Choose OK

The Calendar displays your time zone
adjacent to the Calendar and the second
time zone to the left of your time zone.

The additional time zone area appears.

Making and Moving Appointments
Outlook gives you the flexibility you need to manage your appointments. You usually make appointments in the Day view
of the Calendar, although you can also set an appointment in the Week and the Month views. You can edit and move
appointments as required in all views. Working in the information viewer, you can edit an appointment by inserting and
deleting text, just as you do in a Mail message.
Sometimes you must move an appointment to another day. You can easily modify the date of an appointment in the Day
and Week views. To move an appointment within the same calendar week, you can drag and drop it within Day and Week
views. To move an appointment farther away in time, you can drag it to the Date Navigator.
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Creating Appointments
The most basic method of making an appointment is simple—click a time slot or drag a time period in your Calendar
to select it, and then type a description of the appointment. As you type the text of an appointment, the text appears on
the screen. If the displayed time slot is not wide enough, the text wraps automatically to the next line when it gets to the
right edge of the appointment area.
When you finish describing an appointment, Outlook saves the entry as soon as you click somewhere outside the
appointment time slot. Even if you choose to exit the program, you do not need to click a Save button or choose Save
from a menu to save your appointment.
You can make a more detailed appointment using the New Appointment window, shown in Figure 4‑5. In this window,
you can enter additional comments about the appointment, such as the materials you should bring with you to the
appointment, directions to the location, and so forth.
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By default, Outlook sends you a reminder about your appointments before each appointment. If you want to cancel the
reminder or change the interval before the appointment for the reminder to appear, you can do so in the New Appointment
window. A bell icon appears in the time slot to indicate that you set a reminder for the appointment.

Figure 4‑6: The New Appointment Window

You access the New Appointment window by clicking the New Appointment button located on the Calendar toolbar.

Method
To select a time slot or time period:
1. In the Calendar (Day, Week, or Month view), display the desired date.
2. Click the time slot.
or
3. Drag through as many time slots as necessary.
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To create a basic appointment:
1. Select a time slot or time period.
2. Type a description.
To create a detailed appointment:
1. If desired, select a time slot or time period.
2. Double-click the selected time slot or time period.
or
3. On the toolbar, click the New Appointment button.
4. In the New Appointment window, on the Appointment page, in the Subject text box, type the subject.
5. In the Location combo box, type the location or select it from the drop-down list.
6. If necessary, modify the Start time and End time displayed.
7. If desired, in the large text box at the bottom of the page, type comments about the appointment.
8. On the toolbar, click the Save and Close button.

Exercise
In the following exercise, you will create appointments.
1.

At your instructor’s direction, click a
thirty-minute time slot approximately one
hour from the current time

The time slot is selected.

2.

Type Call to check for new deliveries

A Call to check for new deliveries
appointment appears in your selected time
slot.

3.

Position the mouse pointer over the 2:00
p.m. time slot

4.

Drag through the 3:00 p.m. time slot

A 1½-hour time period is selected. The
previous appointment is saved.

5.

Type Design new floor plan

A Design new floor plan appointment
appears in your selected time slot.

6.

On the toolbar, click the New
Appointment button

The New Appointment window appears.
The previous appointment is saved.

7.

On the Appointment page, in the Subject
text box, type Reconcile accounts

8.

In the Location combo box, type office

9.

In the left Start time combo box, select
the date and then type first Monday of
next month

Download free eBooks at bookboon.com
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10.

In the right Start time combo box, select
the time and type nine a.m.

The entry in the left Start time combo box
changes to show the actual date when you
clicked or tabbed to the next data entry
field.

11.

In the right End time combo box, select
the time and type noon

The entry in the right Start time combo box
changes to show the time in numerals when
you clicked or tabbed to the next data entry
field.

12.

In the Reminder area, make sure the
Reminder check box is selected

13.

In the Reminder drop-down list box,
make sure 15 minutes is selected

14.

In the large text box at the bottom of the
window, type Get someone to cover
phones.

The entry in the right End time combo box
changes to show the time in numerals when
you clicked or tabbed to the next data entry
field.

15.

On the toolbar, click the Save and Close
button

The Calendar for today reappears.

16.

Display the Calendar for the first Monday
of next month

The Calendar appears displaying the new
appointment on the first Monday of next
month.
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Selecting an Appointment and Modifying the Date in Day View
When you modify appointment details, you need to select the appointment before you can edit it. Figure 4‑6 shows the
Calendar with an appointment selected.

Figure 4-7: The Calendar with an Appointment Selected

When you must move an appointment to a different week, the simplest way is to use the Date Navigator in Day view.
You position the mouse pointer over the move handle, which is the blue line to the left of the appointment. The pointer
becomes a four-headed arrow, shown in Error! Reference source not found., which you use to drag the appointment to
the Date Navigator. You select the appointment when you begin to drag it. If you want to reschedule the appointment for
the following month, you can adjust the Date Navigator’s width to show two months.

Method
To select an appointment:
1. Click the appointment.
To change the date of an appointment in Day view:
1. Position the mouse pointer over the appointment.
2. Drag the appointment to the desired date on the Date Navigator.
or
Download free eBooks at bookboon.com

24

Outlook 2007: Part II

Scheduling with Calendar

3. From the Edit menu, choose Cut.
4. On the Date Navigator, click the new date or time.
or
5. Display the desired day.
6. From the Edit menu, choose Paste.

Exercise
In the following exercise, you will move the date of an appointment from one week to another and from one month to
another in Day view.
1.

Display today’s appointments in Day view

2.

Adjust the Date Navigator to show two
months

The View Menu then select to do bar and then
select options

3.

Position the mouse pointer over the
Design new floor plan appointment

.

4.

Drag the appointment to Friday of next
week on the Date Navigator

The appointment now takes place on Friday of
next week and Friday of next week appears in
the Calendar.

5.

Position the mouse pointer

6.

Drag the appointment to the first
Wednesday of next month on the Date
Navigator

7.

Position the mouse pointer

8.

Click the appointment

9.

From the Edit menu, choose Cut

The appointment is placed on the Clipboard.

10.

On the toolbar, click the Go to Today
button

Today’s date appears in the Calendar.

11.

From the Edit menu, choose Paste

The appointment is scheduled for today at its
original time.

12.

Adjust the Date Navigator to show just
one month

The appointment now takes place on the
first Wednesday of next month and the first
Wednesday of next month appears in the
Calendar.

Modifying the Date in Week View
You can also move an appointment in Week view. You can drag it to a new date displayed on the calendar or on the Date
Navigator. Figure 4‑8 shows the Calendar in Week view.
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Figure 4‑8: The Calendar in Week View

.
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Method
To modify the date of an appointment in Week view:
1. Position the mouse pointer over the time area of the appointment.
2. When the pointer becomes a four-headed arrow, drag the appointment to the new date on the Calendar or
on the Date Navigator.

Exercise
In the following exercise, you will modify the date of your appointment in Week view.
1.

On the toolbar, click the Week button

The Week view appears.

2.

Position the mouse pointer over the
time area of the Design new floor plan
appointment

The mouse pointer becomes a four-headed
arrow.

3.

Drag the appointment to Friday on the
Calendar

The appointment now takes place on Friday
from 2:00 p.m. to 3:30 p.m.

4.

Position the mouse pointer over the time
area of the appointment

The mouse pointer becomes a four-headed
arrow.

5.

Drag the appointment to Wednesday on
the Date Navigator

The appointment now takes place on
Wednesday.

6.

If today is not Wednesday, position the
mouse pointer over the time area of the
appointment

The mouse pointer becomes a four-headed
arrow.

7.

Drag the appointment to today’s date on
the Calendar

The appointment now takes place today.

8.

On the toolbar, click the Day button

Today’s Calendar appears in Day view.

Changing the Time of an Appointment
Outlook lets you easily modify the beginning and ending times of an appointment. If you must move an appointment to
another time slot in the same day, you can drag it there with the move handle. You can change just the start-up time of
an appointment by dragging the top appointment handle with the double-headed arrow or change just the ending time of
an appointment by dragging the bottom appointment handle with the double-headed arrow. The appointment handles
are the blue borders at the top and the bottom of a selected appointment that allow you to change the appointment
beginning and ending times.

Method
To move an appointment to another time slot on the same day:
1. Position the mouse pointer over the move handle.
2. When the pointer becomes a four-headed arrow, drag the appointment to the new time slot.
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To change the start up time or the ending time of an appointment:
1. Position the mouse pointer over an appointment handle.
2. When the pointer becomes a double-headed arrow, drag the appointment handle to the new time.

Exercise
In the following exercise, you will change the time of your appointment.
1.

Position the mouse pointer over the
Design new floor plan appointment

2.

Click and Drag the appointment one hour
later

3.

Select the appointment again

4.

Position the mouse pointer over the top
appointment handle

The mouse pointer becomes a double-headed
arrow.

5.

Drag the top handle to 1:30 p.m.

The appointment now begins at 1:30 p.m.

6.

Position the mouse pointer over the
bottom appointment handle

The mouse pointer becomes a double-headed
arrow.

7.

Drag the bottom handle to 3:00 p.m.

The appointment now ends at 3:00 p.m.

Managing Appointments
Outlook provides a variety of more complex time-management capabilities, including creating recurring appointments
and tentative appointments. Recurring appointments are those appointments in your schedule that occur regularly, such
as a biweekly review of orders or preparing a monthly report. Tentative appointments are those appointments for which
you need to reserve a time slot even though they might not take place.
You can also mark events, days on which you observe or celebrate something while conducting business as usual. For
example, you would mark your birthday as an event. You can also mark a conference as an event, and then schedule the
individual sessions you plan to attend as appointments.
In addition, should you need to cancel an appointment, Outlook lets you delete it so you can schedule another appointment
in your newly freed time period.

Creating Recurring Appointments
When you schedule a recurring appointment, Outlook automatically places all future occurrences of the appointment
in your Calendar for the period you specify. The Appointment Recurrence dialog box, illustrated in Figure 4‑9, lets you
define recurring appointments.
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Figure 4‑7: The Appointment Recurrence Dialog Box

When you have scheduled a recurring appointment, your Calendar shows the Recurrence icon, a circle made from two
arrows, which appears at the left of the appointment, as shown in Figure 4‑10.

Figure 4‑8: A Recurring Appointment Displaying the Recurrence Icon

Method
To create a recurring appointment:
1. Select a time slot or time period.
2. From the Calendar menu, choose New Recurring Appointment.
3. In the Appointment Recurrence dialog box, in the Recurrence pattern area, in the left column, select a time
period option button.
Download free eBooks at bookboon.com

29

Outlook 2007: Part II

Scheduling with Calendar

4. In the Recurrence pattern area, in the right column, select the appropriate option button or check boxes and,
if necessary, fill in the required information.
5. In the Range of recurrence area, select the appropriate end date option button and fill in required
information.
6. Choose OK.
7. Complete the New Appointment window, and then, on the toolbar, click the Save and Close button.

Exercise
In the following exercise, you will create a recurring appointment.
1.

On the Calendar, select 11:00 a.m. to 2:00
p.m. on the third Monday of next month

2.

From the Calendar menu, choose New
Recurring Appointment

3.

In the Recurrence pattern area, in the left
column, select the Monthly option button

4.

In the Recurrence pattern area, in the
right column, select the second option
button

5.

In the Range of recurrence area, make
sure the No end date option button is
selected

6.

Choose OK

7.

In the Subject text box, type Mayor’s
monthly business lunch

8.

In the Location text box, type restaurant

9.

In the large text box at the bottom of the
window, type The mayor always orders
stuffed grape leaves.

10.

On the toolbar, click the Save and Close
button

The Appointment Recurrence dialog
box appears over the New Appointment
window.

The New Appointment window appears.

The appointment appears on the Calendar
displaying the subject and the location. The
appointment displays the Recurrence icon.

Editing Recurring Appointments
You can edit recurring appointments by reopening the Appointment Recurrence dialog box. Before this dialog box appears,
however, the Open Recurring Item message box, shown in Figure 4‑11, appears. In this message box, you specify whether
the change is for this occurrence only or for the entire series.

Download free eBooks at bookboon.com

30

Outlook 2007: Part II

Scheduling with Calendar

Figure 4‑9: The Open Recurring Item Message Box

Method
To edit a recurring appointment:
1. Double-click the appointment.
or
1. Select the appointment, and then, from the File menu, choose Open.
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2. In the Open Recurring Item message box, select the desired option button, and then choose OK.
3. In the Recurring Appointment window, make the changes.
4. If desired, from the Appointment menu, choose Recurrence.
5. In the Appointment Recurrence dialog box, make the changes.
6. Choose OK.
7. In the Recurring Appointment window, on the toolbar, click the Save and Close button.

Exercise
In the following exercise, you will edit a recurring appointment.
1.

If necessary, select the Mayor’s business
lunch appointment

2.

From the File menu, choose Open

3.

Select the Open the series option button

4.

Choose OK

5.

In the Subject text box, select the word
monthly and type biweekly

6.

From the Appointment menu, choose
Recurrence

7.

In the Recurrence pattern area, in the left
column, select the Weekly option button

8.

In the Recurrence pattern area, in the
right column, select the number in the
Recur every…weeks text box, and then
type 2

9.

Choose OK

The Recurring Appointment window shows
the appointment recurring every two weeks
beginning with the selected date.

10.

On the toolbar, click the Save and Close
button

The edited appointment appears on the
Calendar.

The Open Recurring Item message box
appears.

The Recurring Appointment window
appears.

The Appointment Recurrence dialog box
appears.

Creating Tentative Appointments
Sometimes you might want to reserve a time slot even if you are not sure an appointment is definite. For example, if you
want to attend a training class but your supervisor has not approved the expense yet, you can mark the time slot as a tentative
appointment. to reserve the ti Tentative appointments display a light blue move handle to the left of the appointment.
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Method
To create a tentative appointment:
1. Create an appointment but do not close the New Appointment window.
2. From the Options Grouping on the Ribbon, select the down arrow next to busy and select Tentative.
3. On the toolbar, click the Save and Close button.

Exercise
In the following exercise, you will create a tentative appointment.
The Calendar displays next Tuesday.

1.

On the Date Navigator, select next
Tuesday

2.

On the Calendar, select the time period
from 9:00 a.m. to 1:30 p.m.

3.

On the toolbar, click the New
Appointment button

4.

In the Subject text box, type Excel
training class

5.

From the Show time as drop-down list,
select Tentative

6.

On the toolbar, click the Save and Close
button

The New Appointment window appears.

The appointment appears on the Calendar.
The move handle is shaded blue/white..

Inserting All Day Events
You can remember special business and personal days by inserting them using the All Day Event option, shown in
Figure 4‑10. Outlook displays events at the head of your Calendar, as illustrated in Figure 4‑11. Here is a simple place to
list pay days, birthdays, anniversaries, and other significant events that do not require appointments during your work
day. If the event lasts several days, Outlook displays it every day for its duration.
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Figure 4‑10: The New Event Window
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Figure 4‑11: The Calendar with an Event Displayed

> Apply now
redefine your future

- © Photononstop

AxA globAl grAduAte
progrAm 2014

Download
free eBooks at bookboon.com
axa_ad_grad_prog_170x115.indd 1

19/12/13 16:36

35

Click on the ad to read more

Outlook 2007: Part II

Scheduling with Calendar

Method
To insert events:
1. From the Calendar menu, choose New Appointment.
2. In the New Event Appointment, complete the text boxes, select the options buttons and check boxes, and so
forth, as if you were creating a new appointment.
3. Make sure the ‘All day event’ check box is selected.
4. Make sure Free is selected in the ‘Show time’ as drop-down list box.
5. On the toolbar, click the Save and Close button.

Exercise
In the following exercise, you will insert an event.
The New Appointment window appears.

1.

From the Calendar menu, choose New
Appointment

2.

In the Subject text box, type Fiesta
Launch Party

3.

From the Start time drop-down calendar,
type February 24, 2005 or the date your
instructor tells you

4.

Make sure the All day event check box is
selected

5.

Make sure Free is selected in the Show
time as drop-down list box

6.

On the toolbar, click the Save and Close
button

The Calendar reappears.

7.

Go to the date you selected for Mardi
Gras

The event appears above the Calendar on
the selected date.

Deleting Appointments
You should delete appointments as soon as you cancel them. Prompt deletions keep your Calendar up-to-date and give
you and your colleagues an accurate picture for setting meetings. You can use the toolbar button to delete appointments.

Method
To delete an appointment:
1. Select the appointment.
2. From the Edit menu, choose Delete.
or
3. On the toolbar, click the Delete button.

Download free eBooks at bookboon.com

36

Outlook 2007: Part II

Scheduling with Calendar

Exercise
In the following exercise, you will delete an appointment.
1.

Display today’s date

2.

In the Calendar, select the Call to check for
new deliveries appointment

3.

On the toolbar, click the Delete button

The appointment is deleted.

Restoring Deleted Appointments
If you delete an appointment in error and realize your mistake immediately after the deletion, you can restore it quickly.
If you take any other action before restoring the appointment, however, you must recreate the deleted appointment from
scratch.

Method
To restore a deleted appointment immediately after deleting it:
1. From the Edit menu, choose Undo Delete.
or
1. On the toolbar, click the Undo Delete button.

Exercise
In the following exercise, you will restore a deleted appointment.
1.

The Call to check for new deliveries
appointment is restored.

On the toolbar, click the Undo Delete
button

Assignment
1. On the Friday before the third Monday of next month, make a one-hour appointment located in your office
beginning at 9:00 a.m. to review preparations for the mayor’s biweekly luncheon. Make a note that says:
Order all ingredients for stuffed grape leaves.
2. Move the appointment to the Thursday before the third Monday, and then move it forward thirty minutes to
start at 9:30 a.m.
3. Shorten the appointment to end at 10:00 a.m.
4. Display Friday of the previous week. Make a one-half hour appointment that recurs weekly at 4:30 p.m. to
review your staples inventory.
5. Change the inventory appointment to biweekly.
6. On the second Tuesday of every month, create a recurring appointment from 6:00 p.m. to 9:00 p.m. to teach
a culinary course at the New Orleans Culinary Institute.
7. Set a reminder for the culinary course for two hours before the course begins.
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8. On the fourth Friday following the current date, create a tentative appointment from 5:30 p.m. to 6:00 p.m.
for a haircut at Snippets.
9. Delete the haircut appointment and restore it immediately.
10. View your appointments for this week, and then view your appointments for the entire month. Then return
to Day view.
11. Show only your time zone.
12. Insert your birthday as an event in your calendar.
13. Restore your Calendar to today’s date in Day view.
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Section 5 Advanced Formatting
Objectives
At the completion of this lesson you will be able to:
•

Work with Tasks

•

Manage Tasks

Topics
Working with Tasks
Creating a Task
Selecting and Editing a Task
Making a Task Recurring
Deleting and Restoring a Task
Managing Tasks
Setting the Priority for a Task
Tracking a Task’s Status and Marking a Task Completed
Using Task Timeline View
Assignment

Working with Tasks
Tasks are activities or duties you must perform and track through completion. Tasks can be work-related, such as completing
and sending in time sheets, or personal, such as purchasing tickets to an event.
The Tasks folder, shown in Figure 5‑12, lets you define your tasks. You can display all tasks in a simple list or a detailed
list, show only active tasks, show tasks for the next seven days, show overdue tasks, or view your tasks by other criteria.
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Figure 5‑12: Tasks in Simple List View

The TaskPad in your Calendar shows active tasks that you should complete within the next seven days. You can add to
the task list in the Tasks folder or on the TaskPad.

Creating a Task
You can create a simple task in your list by clicking the Click here to add a new Task text box on the task list in the Tasks
folder or on the TaskPad in the Calendar. You then enter your information and click anywhere else on the task list or
press Enter to save your data. To add more detailed information, however, you must use the New Task window, shown in
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Figure 5‑13: In the Task window, you can show the start and due dates, the status, and the priority of the task.
You can also set a reminder for the task.
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Figure 5‑13: The New Task Window

You access the New Task window by clicking the New Task button on the toolbar. Figure 5-3 shows the New Task Window

Figure 5-3: New Task Window Ribbon

Method
To create a task:
Task list method
1. Click the Click here to add a new Task text box.
2. In the text box, type the subject.
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3. If necessary, click the Due Date text box.
4. Enter a due date.
or
5. Click the Due Date drop-down arrow, and then select a date from the Date Navigator.
6. Click anywhere else on the task list.
or
7. Press Enter
New Task window method
1. On the toolbar, click the New Task button.
or
1. From the Tasks menu, choose New Task.
2. In the New Task window, on the Task page, in the Subject text box, type the subject.
3. In the Due Date area, make sure the None option button is selected.
or
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4. In the Due Date area, in the Start combo box, type the start date or click the Start drop-down arrow and
choose a start date from the Date Navigator, and then in the Due combo box, type the due date or click the
Due drop-down arrow and choose a due date from the Date Navigator.
5. If desired, set a reminder.
6. If desired, in the large text box at the bottom of the window, add notes.
7. On the toolbar, click the Save and Close button.

Exercise
In the following exercise, you will create tasks.
1.

Open the Tasks folder

The task list appears in Simple List view.

2.

Click the Click here to add a new Task text
box

The insertion point is in the subject text box.
The word None appears in the Due Date
text box.

3.

Type collect recipes for culinary course

4.

Click the Due Date text box

The Due Date text box becomes a combo
box.

5.

Type first Tuesday of next month

The text appears in the Date Due box.

6.

Press Enter

The new task is added to the task list. The
due date appears as a date.

7.

On the toolbar, click the New Task button

The New Task window appears.

8.

On the Task page, in the Subject text box,
type Make signs for Balloon Fiesta stall

9.

In the Due Date area, click the Start
combo box drop-down arrow, and choose
the Today button

Today’s date appears in the Start combo
box.

10.

In the Due Date area, click the Due
combo box drop-down arrow, and then
choose the first Monday in next March

The date of the first Monday in next March
appears in the Due combo box.

11.

On the toolbar, click the Save and Close
button

The task appears on the task list.

12.

Add the tasks in Table 5‑2 to your task list
Task

Start Date

Due Date

buy copy paper

today

next Tuesday

send flyers re: next month’s
specials to all customers who left
business cards

next Monday

Friday after next Monday

call suppliers about discounts for
bulk orders

today

month from today

Table 5‑12: Additional Tasks for Task List
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Selecting and Editing a Task
Tasks are often not completed as initially conceived. You might find it necessary to change the end date of a task or to edit
the task description. You edit tasks in the Task window. You can also make simple edits directly on the task list.

Method
To select a task:
1. Click the task.
To edit a task:
Task list or TaskPad method
1. Select the task.
2. Make the change.
3. Click anywhere else on the task list.
or
4. Press Enter
Task window method
1. Double-click the task.
or
1. Select the task, and then, from the File menu, choose Open.
2. In the Task window, make the change.
3. On the toolbar, click the Save and Close button.
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Exercise
In the following exercise, you will edit tasks.
1.

On the task list, click the collect recipes for
culinary course Due Date text box

The task is selected. The columns to the left
of the due date become blue. The dropdown arrow appears.

2.

Select the due date and type tomorrow

3.

Click anywhere else on the task list

Tomorrow’s date appears in the Due Date
text box. The edit is saved.

4.

Click the get info on food festival Subject
task box

The task is selected. The columns to the left
and the right of the subject become blue.

5.

Double-click the task

The get info on food festival - Task
window appears.

6.

In the Due combo box, select the text and
then type today

7.

Choose Save and Close

The task list reappears. The task displays the
new due date.

8.

Click the order new tablecloths task

The task is selected.

9.

From the File menu, choose Open

The order new tablecloths - Task window
appears.

10.

In the notes area, change the number of
square tablecloths to 12

11.

On the toolbar, click the Save and Close
button

The task list reappears.

Making a Task Recurring
Some tasks you do routinely—for example, you pick up your paycheck every other Friday. You can define these routine
tasks as recurring tasks so that they are always on your task list. You see the task listed only once, but whenever you
complete the task, the next occurrence then appears on the task list.
You schedule recurring tasks in the Task window using the Task Recurrence dialog box, shown in Figure 5‑3. If a task
already appears on your task list and you want to make it recurring, you can select the task, open its Task window, and
then click the Recurrence button on the toolbar.
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Figure 5‑4: The Task Recurrence Dialog Box

Once you have designated a task as recurring, the Icon field displays the Recurring Task icon, a clipboard with the
recurring task symbol, two arrows in a circle on a gray box. This symbol is similar to the recurring appointment symbol.

Method
To make a task recurring:
1. Select a task and open the Task window.\
or
1. Create a task but do not close the Task window.
2. On the toolbar, click the Recurrence button.
3. In the Task Recurrence dialog box, in the Recurrence pattern area, in the left column, select a time period
option button.
4. In the Recurrence pattern area, in the right column, select the appropriate option button or check boxes and,
if necessary, fill in the required information in the appropriate text boxes.
5. In the Range of recurrence area, select the appropriate end date option button and fill in the required
information.
6. Choose OK.
7. In the Task window, on the toolbar, click the Save and Close button.
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Exercise
In the following exercise, you will make a task recurring.
1.

Select the send fliers re: next month’s
specials… task and open the Task window

2.

On the toolbar, click the Recurrence
button

The Task Recurrence dialog box appears.

OR
Select from the Action option.
3.

In the Recurrence pattern area, in the
left column, select the Monthly option
button.

4.

In the Recurrence pattern area, in the
right column, select the second option
button

5.

In the Range of recurrence area, select the
End after option button, and then select
the text in the text box and type 6

6.

Choose OK

The Task window reappears. An information
area that tells you when the task is due,
when the task starts, and how long it is
effective appears just below the tabs.

7.

On the toolbar, click the Save and Close
button

The task is recurring. The task list reappears.
The icon cell displays the Recurring Task
icon.

Deleting and Restoring a Task
When you are no longer responsible for a task on your task list and you have not done any work on it, you should delete
the item from your list. If you delete a task in error, you can immediately restore it.
Note: Since Outlook is a record of your activities, you should not delete partially
completed and completed tasks. This can be especially important when auditors come
by or when it is time for your annual performance appraisal.

Method
To delete a task:
1. Select the task.
2. On the toolbar, click the Delete button.
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Managing Tasks
If you have many tasks, you might want to view your task list differently. As in the Mail folder, you can sort your tasks
by clicking the column headers. In addition, you can filter your task list to show a subset of your tasks by clicking the
Current View drop-down arrow.
The Tasks Current View drop-down list gives you numerous criteria to use to filter the messages. Table 5‑3 summarizes
the Tasks Current View filters.
Name

Function

Simple List

Shows the subject line, task type, status, and due date of all
tasks.

Detailed List

Shows the Simple List with such additional details as priority,
whether there are attachments, and categories.

Active Tasks

Shows only those tasks that are incomplete.

Next Seven Days

Shows only those tasks due in the next seven days.

Overdue Tasks

Shows only those tasks that are overdue.

By Category

Groups tasks by category.

Assignment

Groups tasks by who assigned them to you.

By Person Responsible

Groups tasks by who is responsible for their completion.

Completed Tasks

Shows only completed tasks.

Task Timeline

Graphically shows when each task was assigned, its duration,
and its completion date.

Server Tasks

Show tasks stored on a Server typically Microsoft Exchange

Outlook Data Files

Shows Data Files

To-Do List

Show active to do list
Table 5‑13: The Tasks Current View Filters

When you assign priorities to your tasks, you can decide which task to work on based on its importance and its due date.
You should also track the status of a task and check it off when you complete it.

Setting the Priority for a Task
While it is important that you complete all tasks punctually, some tasks are more important than others, and you should
work on them first. Outlook lets you set the priority on tasks so you can quickly evaluate how to best use your time. You
can use the Task window to set your task priority shown in Figure 5‑5. You can select Low, Normal or High priority,
Normal is selected by default. Or, if you already have a task on your list, you can display the list in a detailed view and add
a priority symbol to the task by clicking the Priority column header, The symbol for low priority is a blue arrow pointing
down and for high priority is a red exclamation point. Normal priority has no symbol.
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Figure 5-5: Setting Priority

Note: The Priority column header is not visible when you filter your Current View as
Simple List or as Task Timeline.

Method
To set the priority for a task:
Task window method
1. Select a task and open the Task window.
or
1. Create a task but do not close the Task window.
2. In the Task window, click the Priority drop-down list box, and then select a priority.
3. On the toolbar, click the Save and Close button.
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Detailed list method
1. In any task list view that shows the Priority column, click the Priority column cell for the task.
2. From the drop-down list, select a priority.
3. Click anywhere on the task list.
or
4. Press Enter

Exercise
In the following exercise, you will set the priority for several tasks.
1.

Open the buy copy paper Task window

2.

Click the Priority drop-down list box, and
then select High

3.

On the toolbar, click the Save and Close
button

The task list reappears.

4.

On the toolbar, click the Current View
drop-down list arrow, and then select
Active Tasks

A red exclamation point appears in the
Priority column cell of the buy copy paper
task.

5.

Click the priority column cell for the get
info on food festival task

A drop-down list appears.

6.

Select High

A red exclamation point appears in the
Priority column.

7.

Click anywhere on the task list

The priority is saved.

Tracking a Task’s Status and Marking a Task Completed
Each time you work on a task, you should track its status on the Details page of the Task window, shown in Figure 5‑6.
You can enter such details as how many hours the task lasted, who to bill, who you contacted, and so forth on this page.
You can show that a task is in progress and approximate how close to completion you are on the Task page.
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Figure 5‑15: The Details Page of the Task Window

When you finish a task, you should mark it as completed so that it no longer appears on your active tasks list. You can
simply check it off on your TaskPad or task list using the check box in the complete column or you can mark it in the
Task window. Figure 5‑7 shows the complete column header. You can also set the % completed of the task using the new
task window

Figure 5-16: The Complete Column Header

Note: The Complete column header is only visible when you filter your Current View as Simple List.
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Method
To track a task’s details and status:
1. Open the task window.
2. On the Task page, click the Status drop-down list box, and then select a status.
3. In the % Complete spin box, click a spin arrow or enter a percentage.
4. Select the Details tab.
5. On the Details page, enter the desired details in the appropriate text boxes.
6. On the toolbar, click the Save and Close button.
To mark a task completed:
1. On the TaskPad or on the task list in Simple List view, select the Complete check box for the completed task.
or
2. In the Task window, on the Task page, click the Status drop-down list box, and then select Completed.
3. On the toolbar, click the Save and Close button.

Brain power

By 2020, wind could provide one-tenth of our planet’s
electricity needs. Already today, SKF’s innovative knowhow is crucial to running a large proportion of the
world’s wind turbines.
Up to 25 % of the generating costs relate to maintenance. These can be reduced dramatically thanks to our
systems for on-line condition monitoring and automatic
lubrication. We help make it more economical to create
cleaner, cheaper energy out of thin air.
By sharing our experience, expertise, and creativity,
industries can boost performance beyond expectations.
Therefore we need the best employees who can
meet this challenge!

The Power of Knowledge Engineering

Plug into The Power of Knowledge Engineering.
Visit us at www.skf.com/knowledge
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Exercise
In the following exercise, you will track a task’s status and you will mark tasks completed.
1.

Open the Calendar folder

2.

On the TaskPad, select the buy copy paper
Complete check box

3.

Open the Tasks folder

4.

Click the Current View drop-down list
arrow, and then select Simple List

5.

On the task list, select the order new
tablecloths Complete check box

6.

From the task list, open the call suppliers
about discounts for bulk orders Task
window

7.

On the Task page, click the Status dropdown list box, and then select In Progress

8.

In the % Complete spin box, type 10%

9.

On the toolbar, click the Save and Close
button

10.

From the task list, open the get info on
food festival Task window

11.

On the Task page, click the Status dropdown list box, and then select Completed.

The text in the % Complete text box
becomes 100%.

12.

Select the Details tab

The Details page appears.

13.

In the Total work text box, type 20
minutes

14.

In the Actual work text box, type 20
minutes

15.

In the Mileage text box, type none

16.

On the toolbar, click the Save and Close
button

A check appears in the Complete check box
and a line appears through the subject.

A check appears in the Complete check box
and a line appears through the subject and
the due date.

The task list reappears.

The task list reappears. A check appears in
the Complete check box and a line appears
through the subject and the due date.

Using Task Timeline View
Filtering the Current View as Task Timeline, shown in Figure 5‑8, shows you, your task list in timeline format. When
you view your tasks with this filter, you can visually analyze which tasks you must work on to complete everything in a
timely fashion. You can open the Task window from this view to enter data.
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Figure 5‑17: The Tasks Folder in Task Timeline View

Method
To use Task Timeline view:
1. On the toolbar, click the Current View drop-down arrow, and then select Task Timeline.
2. Examine the timelines.
3. If desired, select a task, and then double-click it.
4. In the Task window, make desired changes.
5. On the toolbar, click the Save and Close button.

Exercise
In the following exercise, you will use Task Timeline view.
1.

On the toolbar, click the Current View
drop-down arrow

The drop-down list appears.

2.

Select Task Timeline

The task list appears in Task Timeline view.

3.

Examine the list

4.

Return the Current View to Simple List
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Assignment
1. Add hire assistant chef to your task list. Set the priority as high.
2. Add make kitchen clean-up check list to your task list.
3. Add send out Bristol and West Restaurant Association mailing to your task list. Set this up as a task that
recurs monthly on the fifth of each month. Show this as a one-year commitment.
4. You have an hour appointment to interview Barry Wise tomorrow morning for the assistant chef position.
Show the Hire assistant chef task as in progress and 25 percent complete.
5. Change the collect recipes for culinary course task to read get recipes from Charlotte for culinary course
6. Delete the Make signs for Balloon Fiesta stall task, and then restore it.
7. Examine your task list in Task Timeline view. Then, view your task list in Next Seven Days view.
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Section 6	Keeping a Journal and
Utilising Notes
Objectives
At the completion of this lesson you will be able to:
•

Tracking Activities

•

Working with Notes

Topics
Tracking Activities
Recording Activities Automatically
Setting Shortcut Opening Options and Using a Journal Entry as a Shortcut
Working with Notes
Writing a Note
Opening and Editing a Note
Organising Notes
Changing Icon Size
Assignment

Tracking Activities
The Journal is where you record all documents on which you work. Figure 6‑1 shows a sample journal viewed by entry
type in month view. The timeline shows e-mail and Word documents and when they were opened.
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Figure 6‑18: A Sample Journal Filtered by Entry Type in Day View. Below – The journal tracks your Office files
so that when you double click the icon it opens up for editing/reading.

You can set up the Journal to record your Microsoft Office activities automatically. You can also list your other activities
manually, whether you open a non-Office document or you want to record a conversation, an appointment, a contact,
or anything else of importance.
You might need to verify when you worked on a document or talked with a colleague. In such a case, you can use your
Journal to find your activity. Several filters show timelines that emphasize the date and duration of the contact, while
the remaining filters document the quantity of activity. You can change whether the timeline displays a day, a week, or
a month by clicking the Day, Week, or Month buttons on the toolbar, as you did in the Calendar folder. If you want to
open a document that is listed in your Journal, you can open it directly from the Journal listing.
The Journal Current View drop-down list gives you numerous criteria to use to filter the activities. Table 6‑1 summarizes
the Journal Current View filters.
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Name

Function

By Type

Group activities by application type in timeline format.

By Contact

Groups activities by contact in timeline format.

By Category

Groups activities by category in timeline format.

Entry List

Lists all activities recorded. Shows the date, duration, contact,
and category.

Last Seven Days

Shows the entry list for the last seven days.

Phone Calls

Lists phone calls.

Outlook Data Files

Lists Data Files
Table 6‑14: The Journal Current View Filters
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Table 6‑15 summarizes the context-sensitive Journal toolbar buttons.

Button

Name

Function

New Journal

Opens the New Journal Entry window so you can create a
new activity. The drop-down arrow gives you access to the
New windows for the other Outlook features.

Print

Prints your journal

Move to Folder

Move journal to another folder

Delete

Delete Journal Entry

Today

Displays entries for today on timeline

1 Day

Displays one day on the timeline.

1 Week

Displays one week on the timeline.

1 Month

Displays one month on the timeline.

Search Address
book

Searches contacts list

Table 6‑15: Summary of the Journal Toolbar Buttons

Recording Activities Automatically
You set up the Journal to record your activities automatically on the Journal page of the Options dialog box, shown in
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Figure 6‑19: This page governs recording e-mail messages, meetings, tasks assigned to others, and activities with contacts as well as
documents you open in the Microsoft Office.

Figure 6‑19: The Journal Page of the Options Dialog Box
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Method
To record activities automatically:
1. From the Tools menu, choose Options.
2. In the Options dialog box, select the Journal Options button.
3. On the Journal page, in the Automatically record these items: list, select the appropriate check boxes.
4. In the For these contacts: area, select the appropriate check boxes.
5. In the Also record files from: area, select the appropriate check boxes.
6. Choose OK.
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Exercise
In the following exercise, you will automatically record activities in your Journal.
1.

Open the Journal folder

The Journal appears in By Type view.

2.

From the Tools menu, choose Options

The Options dialog box appears.

3.

Click the Journal button.

The Journal Options dialog box opens.

4.

In the Automatically record these items: list,
select all the check boxes

5.

In the For these contacts: list, select the
box

6.

In the Also record files from: area, select all
the check boxes

7.

Choose OK

8.

Open Microsoft Word

9.

From the Data folder on your hard drive,
open the document Journal.doc

10.

Close the document and exit from Word

11.

Open the Journal

An Entry Type for Microsoft Word appears
on the timeline.

12.

Click the + to the left of Entry Type:
Microsoft Word

The Entry Type expands to show your
Microsoft Word activity.

The Journal reappears.

Setting Shortcut Opening Options and Using a Journal Entry as a Shortcut
Suppose you are looking for a document you worked on a week ago and you can no longer recall its name. You can open
items you tracked in your Journal to find the document you want.
The way you set up the Journal page of the Options dialog box determines whether you open the document directly or
you open the Journal Entry window and then the document. By default, double-clicking opens the Journal Entry window.

Method
To set shortcut opening options:
1. From the Tools menu, choose Options.
2. On the Preferences page of the Options dialog box click the Journal button.
3. In the Double-clicking a journal entry: area, select an option button.
4. Choose OK.
5.

Choose OK.
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To use a Journal entry as a shortcut:
1. Double-click the Journal entry.
2. If necessary, in the Journal Entry window, double-click the shortcut in the large text box at the bottom of the
window.

Exercise
In the following exercise, you will set shortcut opening options and you will use a Journal entry as a shortcut.
1.

Change the view to Last Seven Days

2.

If necessary, position the double-headed
mouse pointer over the border that
separates the Subject and the Start
column headers, and then drag the
border to the right

The Subject column becomes wider,
allowing you to see the whole drive path.

3.

In the Subject column, double-click C:\
Data\Journal.doc

The Journal.doc Journal Entry window
appears.

4.

In the large text box at the bottom of the
window, double-click the Journal.doc
shortcut

Word loads and the document opens.

5.

Close the document and exit from Word

The Journal Entry window reappears.

6.

Close the Journal Entry Window

The Journal reappears.

7.

From the Tools menu, choose Options
then click the Journal button.

The Journal page of the Options dialog box
appears.

8.

In the Double-clicking a journal entry: area,
select the Opens the item referred to by the
journal entry option button

9.

Choose OK

10.

Choose OK

11.

In the activity list, double-click C:\Data\
Journal.doc

The document opens.

12.

Close the document and exit from Word

The Journal reappears.

The Options dialog box is shown again.

Working with Notes
Outlook’s Notes folder lets you write casual sticky notes to yourself that you can leave on-screen as a reminder. If you
have notes related to an appointment, a contact, or a task, you should write such notes in the text boxes provided in the
entry windows. You can write and edit the sticky notes and delete them when you no longer need them.

Download free eBooks at bookboon.com

64

Outlook 2007: Part II

Keeping a Journal and Utilising Notes

Figure 6-2: The notes screen

www.sylvania.com

We do not reinvent
the wheel we reinvent
light.
Fascinating lighting offers an infinite spectrum of
possibilities: Innovative technologies and new
markets provide both opportunities and challenges.
An environment in which your expertise is in high
demand. Enjoy the supportive working atmosphere
within our global group and benefit from international
career paths. Implement sustainable ideas in close
cooperation with other specialists and contribute to
influencing our future. Come and join us in reinventing
light every day.

Light is OSRAM
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Table 6‑16 describes the functions of the Notes toolbar buttons.

Button

Name

Function

New Note

Opens a New Note so you can
create a new memo. The dropdown arrow gives you access to
the New windows for the other
Outlook features.

Print

Move to folder

Delete
Categorise
Icons

Displays the icons as large, small, or in a
list.

Icons

Displays the icons as large, small, or in a
list.

Show as list

Displays the Icons as a list

Search Address Books

Allows you to search your contacts list

Table 6‑16: The Notes Toolbar Buttons

You filter the Notes using the Current View drop-down list. Table 6‑4 lists the built-in filters.
Name

Function

Icons

Displays an icon and the full text of each note.

Notes List

Lists each note and lets you sort by subject, date created, and
category.

Last Seven Days

Lists the notes created in the last seven days.

By Category

Groups notes by category.

By Colour

Groups notes by colour.

Outlook Data Files

By Data Files
Table 6‑17: The Notes Current View Filters
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Writing a Note
You write notes in the Notes folder. When you click the New Note button, you see an untitled note that has the current
date and time at its bottom. When you finish writing a note, as shown in Figure 6‑4, you click its Close button to store
it in the Notes folder.

Figure 6‑20: A Note

Method
To write a note:
1. In the Notes folder, click the New Note button.
or
1. From the Note menu, choose New Note.
2. On the note, type your text.
3. Click anywhere outside the note to leave the note open.
or
4. Click the Close button to close the note.
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Exercise
In the following exercise, you will write notes.
1.

Open the Notes folder

Your notes appear.

2.

On the toolbar, click the New Note button

An untitled note appears.

3.

On the note, type Pick up clothes from
dry cleaner.

4.

Click outside the note

The note stays open and appears in the
information viewer and on the taskbar.

5.

From the Note menu, choose New Note

An untitled note appears.

6.

On the note, type Ask Charlotte to
attend the interview tomorrow.

7.

Click the Close button

The note is closed and appears in the
information viewer.

8.

On the taskbar, click the dry cleaner note

The note becomes active.

9.

Close the note

Opening and Editing a Note
A note must be open to edit it. You use the same editing techniques that you use in Word or in your e-mail.

Method
To open a note:
1. Double-click the note.
To edit a note:
1. If necessary, open the note.
2. Make the changes.
3. If desired, close the note.
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Exercise
In the following exercise, you will open and edit a note.
1.

Double-click the note that says, Ask
Charlotte to attend the interview tomorrow.

The note opens.

2.

Between the word Charlotte and the word
to type today

The word is inserted.

3.

Close the note

Organising Notes
Besides sorting and viewing your notes just as you do other Outlook data, you can colour code your notes and you can
change the icon size to read your notes better.

Colour Coding a Note
When you color code your notes by subject, category, project, or other criteria, you can quickly identify related notes
when you are looking at the notes in Icon view. You change the colour of a note when the note is open.

CHALLENGING PERSPECTIVES

Internship opportunities
EADS unites a leading aircraft manufacturer, the world’s largest
helicopter supplier, a global leader in space programmes and a
worldwide leader in global security solutions and systems to form
Europe’s largest defence and aerospace group. More than
140,000 people work at Airbus, Astrium, Cassidian and Eurocopter,
in 90 locations globally, to deliver some of the industry’s most
exciting projects.
An EADS internship offers the chance to use your theoretical
knowledge and apply it first-hand to real situations and assignments
during your studies. Given a high level of responsibility, plenty of

learning and development opportunities, and all the support you need,
you will tackle interesting challenges on state-of-the-art products.
We welcome more than 5,000 interns every year across
disciplines ranging from engineering, IT, procurement and
finance, to strategy, customer support, marketing and sales.
Positions are available in France, Germany, Spain and the UK.
To find out more and apply, visit www.jobs.eads.com. You can also
find out more on our EADS Careers Facebook page.
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Method
To color code a note:
1. Open the note.
2. Right click the note icon.
3. From the drop-down menu, choose Categorise.
4. From the submenu, choose a colour.
5. If desired, close the note.

Exercise
In the following exercise, you will colour code a note.
1.

Open the Ask Charlotte today to attend the
interview tomorrow note

2.

Right click the note icon

A drop-down menu appears.

3.

Choose Categorise

A submenu appears.

4.

Choose red

The colour of the note changes to red.

5.

Close the note

6.

Change the Current View to By Colour

The notes are grouped by colour.

7.

Expand the red notes

The Ask Charlotte today to attend the
interview tomorrow note appears.

8.

Collapse the notes, and then change the
Current View back to Icons

Changing Icon Size
You can change the size of the note icons just as you change icon size in Windows Explorer. Outlook provides three
buttons on the toolbar that determine icon size and placement—Large Icons, Small Icons, and List—shown in Figure 6‑21.

Figure 6‑21: The Icon Buttons
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The large icon size is the default size. When you click the Large Icon button, the notes are arranged horizontally across
the information viewer with the text below each icon. When you click the Small Icon button, the icons are arranged
horizontally with the text to the right of each icon. Clicking the List button gives you small icons arranged in a vertical
list with the text to the right of each icon.

Method
To change icon size:
1. On the toolbar, click an Icon button.

Exercise
In the following exercise, you will change icon size.
1.

On the toolbar, click the Small Icons
button

The icons become small and display the text
to the right of the icons.

2.

On the toolbar, click the List button

The icons appear in a vertical list with the
text to the right of the icons.

3.

On the toolbar, click the Large Icons
button

The icons become large and display
horizontally with the text below the icons.

Assignment
1. Reset the Journal so that it no longer automatically records your e-mail, meeting, and task-related activities.
Set double-clicking to open the Journal entry.
2. Add a fax from Freddie Montra to your Journal. Freddie sent you three assistant chef referrals.
3. View your Journal by phone calls. Add a call to Freddie Montra to thank him for the fax.
4. View your Journal by type. Expand the view to see all your phone calls.
5. From the Data folder, open the Word document Specials List.doc. Then close it. Find the Journal entry for
this Word document. Use the Journal entry as a shortcut to reopen the document.
6. Close Specials List.doc, and then exit from Word.
7. Write a note to invite your sister to visit for the Balloon Fiesta. Change the text to include her family.
8. Make all the personal notes blue and the business notes pink.
9. Change the Current View to By Colour. Expand the Notes list so you can see all notes.
10. Change the Current View to Icons. Change to small icons.
11. Exit and log off from Outlook.
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Appendix A	Additional Features in
Outlook 2007
Objectives
At the completion of this lesson you will be able to:
•

Consider new Outlook 2007 features.

Topics
Word as E-Mail Editor
The Office Ribbon
Autosuggest
Outlook Colour Coded Category Labels
Send/Receive Groups
Editing and adding Mail accounts
Views in Outlook 2007

360°
thinking

.

Miscellaneous Features in Outlook 2007
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thinking

.
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thinking

.
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Word as E-Mail Editor
In earlier versions of Outlook you could select Word as an e-mail editor. Outlook 2007 now has many of the word editing
features and commands built in to make it a comprehensive email editor. However more feature and commands are
available if you install Microsoft Word 2007 as well as Outlook 2007 (see table 1-1).
Feature

Without Word 2007 installed

With Word 2007 installed

Message thread shading in open messages and the
Reading Pane

Yes

Yes

Panning through messages on Tablet PCs

Yes

Yes

Search results highlighting for Instant Search

Yes

Yes

New and improved fonts

Yes

Yes

Smart tag recognition

Yes

Yes

New Save as options

Yes

Yes

Quick Styles gallery

Yes

Yes

Themes

No

Yes

Automatic formatting of bulleted and numbered lists

No

Yes

Automatic formatting of tables

No

Yes

Proofing tools like the dictionary and thesaurus.

No

Yes

SmartArt graphics drawing, charting, and diagramming tools

No

Yes

Captions

No

Yes

Equation Builder

No

Yes

WordArt

No

Yes

Table 1-1 – Outlook feature guide – with and without Word installed

The Office Ribbon
The Ribbon is a new feature is Office 2007 and is featured to some degree in each package e.g. Outlook, Excel, Word etc.
The Ribbon has been designed to replace the old File, Edit etc menu system and is more intuitive i.e. commands are now
where you would expect to find them.

Figure 1-1: Example of the Office 2007 Ribbon
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Autosuggest
Outlook 2007 will Autosuggest addresses as you type in recipient names, drawing from a list of the recipients you send
messages to most often.
Microsoft Outlook 2007 now remembers and stores the e-mail addresses you type in the From, To, Cc, and Bcc boxes.
When you begin entering a previously typed e-mail address, Outlook automatically recognises it and offers to complete
the text for you, as shown in Figure 1-22. To accept a suggestion, all you have to do is press the ENTER key.

Figure 1-22: The AutoSuggest prompt

For e-mail addresses with the same first three characters, Outlook provides all applicable suggestions in a drop-down box.
In Figure 1-22 you might want to press the DOWN ARROW key to select the e-mail address you want, and then press
ENTER. If stored addresses exceed seven, a scroll bar will appear. To delete stored e-mail addresses from the drop-down
box, simply use the arrow keys to select the e-mail address you want to delete, and then press DELETE.
METHOD
To turn off automatic completion of e-mail addresses
1. On the Tools menu, click Options.
2. Click E-mail Options, and then click Advanced E-mail Options.
3. Under When sending a message, clear the Suggest names while completing To, Cc, and Bcc fields check
box. On the Standard toolbar, click the Open button.
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Outlook Colour Coded Category Labels
Outlook 2007 includes a Colour coding feature. You can now Colour calendars in the day, week or month view either
manually or with an automatic formatting rule.
Figure 1-3 shows the Colour Label picker menu.

Figure 1-3: The Colour Labels picker

Method
To use Colour Labels:
1. Select the item to Categorise.
2. From the Edit menu, choose Categorise.
3. Select a Colour.
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Editing Colour Labels
The Edit Labels command lets you change the text associated with each Colour. (Note: you can change the available
Colours.) For example, in Figure 1-3 “Meeting can be set to Yellow” has been changed to “Business”.

Figure 1-4: The Edit Calendar Labels dialog box

Method
To Edit Colour Labels:
1. Select Edit, Categorise.
2. Select All Categories from the Colour Label Colour menu.
3. In the Edit Calendar Labels dialog box click next to a Colour you want to edit the name of.
4. Type in the value box your new label.
5. Click OK
Note: You can pick any colour you wish and give any name to your category. You can also assign shortcut keys to
your chosen category allowing you to quickly label any appointment, task etc.
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Tips for using the Colour labels:
•

If you use the Edit Labels feature to change the text for a label, be sure to keep a list of the original label text
and the new text. You’ll need the original text if you want to filter or group by the Label field.

•

Outlook 2007 extends the automatic formatting feature to the Day/Week/Month view using the Colour
labels. Right-click anywhere in a day/week/month view calendar, and choose Automatic Formatting. For
example, you can use automatic formatting to create a rule that looks for every appointment where the
subject contains “birthday” and set those appointments to use the purple Birthday Colour.

•

To apply labels in bulk to existing appointment items without using automatic formatting, create a new table
view and set it to group by the Label property. You can then drag items from the Label: None group to the
group whose label you want to apply to those items. Remember that table views use the built-in label names
and ignore the names you may have customised, so keep that list of your customisations handy.

Send/Receive Groups
In Outlook, mail accounts are organised into groups. When you edit these groups, at the basic end you can specify how
often outlook checks on the server for messages (or dials up if stand alone). At the more complex end, you can optimise
the groups so that certain accounts are collected when you Outlook does a standard send/receive.
Occasionally you should check the Send/Receive group settings to make sure your accounts are organised the way
you want. Use Tools | Send/Receive | Send/Receive Settings | Define Send/Receive Groups. In particular, if you use
Exchange Server with an offline folders file, you can configure which folders are available offline and whether Outlook
synchronizes when you exit.

We will turn your CV into
an opportunity of a lifetime

Do you like cars? Would you like to be a part of a successful brand?
We will appreciate and reward both your enthusiasm and talent.
Send us your CV. You will be surprised where it can take you.

Send us your CV on
www.employerforlife.com
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Figure 1-5: The Send/Receive Groups dialog box

Editing and adding Mail accounts
This aspect has undergone change in this version. The Edit E-Mai Accounts operator or wizard replaces the Tools |
Services configuration settings for Outlook 97 and Corporate/Workgroup mode in Outlook 98 and 2000 and replaced
the Tools | Accounts dialog in Internet Mail Only mode in Outlook 98 and 2000. The necessary settings are no longer
concentrated in one location.
The reasoned effect of these major changes is that Outlook 2007 eliminates the distinction between Corporate/Workgroup
and Internet Mail Only modes that made supporting Outlook 98 and Outlook 2000 so difficult. Using a new account
management interface, a user can connect Outlook to a combination of accounts from these types of servers:
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•

POP or IMAP

•

HTTP (so far for Hotmail and MSN only)

•

Exchange Server

•

Other servers supported via MAPI transports

Outlook 2007 also overhauls the concept of synchronizing with an Exchange Server, introducing Send/Receive groups that
apply not just to Exchange accounts, but to all mail accounts. Users will be able to build account groups that download
headers only, headers + message bodies, or entire messages including attachments from any combination of accounts.
Filtering will apply not just to Exchange accounts, but also to other mail accounts. All send/receive operations will support
progress dialogs.

Managing Accounts
In Outlook 2007, you manage mail accounts, add or delete address books, and change the default delivery location with the
Tools | Account Settings wizard (first step shown in Figure 1-6). To add, remove, compact or add passwords to Personal
Folders files, use File | Data File Management.
To change the settings formerly found in Tools | Services | Addressing, such as the name resolution order, choose Tools
| Address Book, then Tools | Options. To change the sort order for the Outlook Address Book, choose Tools | E-mail
Accounts | View or change existing address books or directories, select the Outlook Address Book, and then click Change.
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Figure 1-6: The E-mail accounts editor wizard

Method
To make changes or edit an existing E-Mail account:
1. Select Tools, Account Settings.
2. In the Account Settings dialog box (Figure 1-6) make sure E-Mail tab is selected.
3. Click an account name in the E-Mail accounts dialog box (Figure 1-6.
4. Click the Change button.
5. Make the required changes.
6. Click Next.
7. Click Finish.

Views in Outlook 2007
To show birthdays for a particular month
1. Go to the Calendar Folder.
2. Select View |Current View |Annual Events to change to the Annual Events view.
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3. Create a filter View |Arrange By | Current View | Customise Current View | Filter) to search for the word
“Birthday” in the Subject field.
4. In the Filter dialog box, switch to the Advanced tab.
5. Choose the appropriate option.
6. Click OK, and you’ll see a list of all of the birthdays in your calendar during that month.

To show separate business and personal calendars
This applies to all versions of Microsoft Outlook
1. Add two categories -- Personal and Business work fine -- and apply one or the other to each of your
appointments.
2. Create two filters for the Calendar folder, one to show only the Personal category, the other displaying only
the Business category. (Or you might set up the second filter to show everything that isn’t the Personal
category -- just to make sure you don’t miss any uncategorized appointments.)
3. Right-click the Calendar icon in the Outlook Bar and choose Open in New Window. Apply the Personalonly filter to this window.
4. Right-click the Calendar icon in the Outlook Bar and choose Open in New Window. (This is the second
Calendar window) Apply the other filter to this window.
You should now have 3 Outlook windows -- one for your Personal calendar, one for the rest of your appointments and
the original window, where you can view e-mail, Contacts, etc. If you still have all three open when you close Outlook,
the Calendar windows, with their filter settings, should be restored the next time you run Outlook.

Tip: To display weekday names in a Calendar weekly view
Outlook depends on the “long” date format set for all Windows programs. Use Control Panel | Regional Settings | Date
to change the long date format so that it includes the name of the day of the week.
Miscellaneous Features in Outlook 2007

The Attachment Preview Feature
Outlook 2007 includes an Attachment preview feature that allows you to preview an attachment before you open it. This
can be quite useful especially if you have a lot of attachments to one email and are looking for a specific one. Figure 1-7
shows the attachment preview feature.
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Figure 1-7 : Attachment Preview Feature

Method
To use the attachment preview:
1. Select an email message with an attachment.
2. Single click on the attachment icon as highlighted in Figure 1-7
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Classroom Setup

Objectives
•

Classroom Setup

Topics
Preparing Outlook on Your Server
Preparing Files and Sending Messages
Preparing Outlook on Each Workstation
Changing Outlook Default Settings
Import and Export Wizard
After Training or Before Your Next Outlook Course

Preparing Outlook on Your Server
Preparation of Outlook for class falls into two categories:
•

actions that you or your Mail/Outlook Administrator must perform on your server to create student
mailboxes

•

actions that you must take to copy student data files and send messages to each class member

The Mail/Outlook Administrator for your local area network can be a key partner in assisting you to prepare for a
successful Outlook class. The simplest way to prepare for the class, if you are already running on a LAN with Microsoft
Mail or Outlook, is for your administrator to set up the necessary mailboxes.
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Option 1: Setting Up Outlook on a LAN
The Mail/Outlook Administrator should create student and instructor user names and groups as indicated in Table D‑1
below.
Student User I.D.s

Create a minimum of 8 mailboxes as follows. The
Name and Mailbox name should be the same.
student1 student2 student3 student4
student5 student6 student7 student8

Instructor User I.D.

Create a mailbox for the instructor. The Name and
Mailbox name for the instructor is Instruct.

Groups

Create a group called Class that contains all the
names of the students and the instructor.

Passwords

The default password for Outlook is password.
You might want to change the initial password to
something else.
Table D‑18: Mail/Outlook Administrator User Setup

Preparing Files and Sending Messages
The data diskette/CD included with this course contains several files that are used as the basis for student messages,
contacts, and notes.

Journal.doc and Specials List.doc
The Journal.doc and the Specials List.doc files are Word document files for use with Section 6, Keeping a Journal and
Utilizing Notes. Copy these files to each workstation by opening Explorer and copying the Data folder from the data
diskette to the root level of the hard drive.

Mailbox.pst
The mailbox.pst file on the data disk contains the initial data you need to install on each student’s computer. This data
includes sent messages, contacts, and notes that students view in Section 1 and use from time to time in other sections.
Copy this file to the default mail folder on each workstation. If Microsoft Exchange was previously installed on the
workstation, this folder will be C:\Exchange. If you want to use a folder other that the default, first, create the new folder.
Then, use Mail in the Control Panel to create a new profile at each workstation. When the Wizard prompts you for the
location of your Personal Address Book and Personal Folder, enter the name of the new folder.
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.rtf Files
The .rtf files and the corresponding message titles listed in Table D‑2 are for your use in preparing messages for the class.
These files are also located on the accompanying data disk.
File/Message Name
Outlook
Kerry Owen Farewell
Vendor Meeting
Table D‑19: Message Files for the Class

Method
To prepare and send a message for class:
1. Start Outlook.
2. Start WordPad or Word.
3. Open the Outlook.rtf file and copy all the text.
4. Switch back to Outlook (on the taskbar, click the Inbox button).
5. On the toolbar, click the New Message button.
6. Address the message to the Class group.
7. Enter the message subject using the message title.
8. Paste the text you copied in WordPad into the message body.
9. Send the message.
or
10. Close the message without sending, and send the message immediately before class.

Preparing Outlook on Each Workstation
Before a student can use Outlook for the first time on a workstation, you must create a user profile on that workstation.
Subsequent students can use the previously prepared profile.
Each class session should appear to be the first that anyone is using Outlook on each student workstation. You must
prepare the workstation so that the default Outlook settings match the settings in the lessons.

Creating a User Profile on a Workstation
Each student workstation must have a user profile. You only need to create this profile once. Assign the first workstation the
user name student1, the second student2, and so forth, matching the names you used in setting up Outlook on your server.
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Method
To create a user profile on a workstation:
1. In the Control Panel, double-click the Mail icon.
2. In the Mail Setup dialog box, click the Show Profiles button.

3. In the Mail dialog box, on the General page, choose Add, and then follow the instructions in the Inbox
Setup Wizard. Make the following selections:
a) For the information service, select Microsoft Mail.
b) For the Profile Name, use student1, student2, and so forth.
c) For the postoffice path, check with your system administrator, or, if you’ve set up your own postoffice,
choose Browse and navigate to the computer and directory on which the postoffice is stored. Expand the
Postofc folder and select the wgpo0000 folder.
d) From the user list, select student1, student2, and so forth.
e) For the password, type password or the password you assigned when setting up the user.
f) For the Personal Address Book, indicate the directory into which you copied the mailbox.pst file.
g) For the Personal folders, indicate the same directory as the previous step.
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Changing Outlook Default Settings
When you install Office, do at least a typical installation, including Outlook and Word. Be sure to install the Office Assistant
and have one or more Office CD-ROMs available in the classroom for changing the Office Assistant. Use Microsoft Word
as the e-mail editor.
In the Outlook Options dialog box, make the following changes to the default settings:
•

On the AutoArchive (Tools>Options>other page>AutoArchive) page, deselect the Run AutoArchive every…
days at startup check box.

•

On the Calendar page, in the Calendar working hours area, in the Start time drop-down list box, enter 9:00
AM.
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•

On the E-Mail Options page, select the Close original message on reply or forward check box.

•

On the Spelling page, select the Always check spelling before sending check box.
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Checking Your Setup
After you’ve configured the mail server and each workstation, check each workstation. Log in with the user name and
password that you assigned to the workstation. Make sure the three messages appear in the Inbox. You should also see
entries in other folders, such as Calendar, Contacts, Tasks and Notes. If these entries are not present, you will need to
import the mailbox.pst file.

Method
To import the mailbox.pst file:
1. From the File menu, choose Import and Export.
2. In the first page of the Wizard, select Import from another program or file and then choose Next.
3. In the next page of the Wizard, in the File to import text box, enter the location of the mailbox.pst.
4. In the Options area, make sure Replace duplicates with items imported is selected, and then choose Next.
5. In the next page of the Wizard, accept the defaults and then choose Finish.
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Import and Export Wizard

After Training or Before Your Next Outlook Course
After each course or before your next Outlook course, delete the mailbox.pst file and replace with a fresh copy from
the Data diskette. Resend the messages required for the course. The files in the Data folder are not modified during the
course and don’t need to be replaced.
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Office 2007
Topics
Office 2007 – A New Platform
At a Glance Highlights Across the Suite
New Visual and navigational Features
File formats
User Assistance System (HELP)
Collaboration features
Themes and Quick Styles
Application-specific changes
General Keyboard Navigational Tips in Office 2007
Beyond Office 2007

Office 2007 – A New Platform
New Workspace Environment
Office 2007 applications share a common user interface, as with previous versions. So, when you’ve learned how to navigate
around one application, you can apply the same concepts and a lot of the commands to the other applications in the suite.
But the workspace environment has changed dramatically in version 2007.
Unlike in previous versions, this has extended to Microsoft Access. Previously the database application worked a bit
differently to the other applications in the suite. The views and ways of working in Microsoft Access are now pretty similar
to those in Word and Excel, so even if you don’t know anything about the concept of database design and administration,
you’ll see a lot of familiarity in the application after using other applications in the suite.
But, the visual aspect has changed and gone is the primary menu-driven way of working Office applications. The new
workspace uses toolbars as the primary method, although many buttons and icons launch drop-down menus or options
menus. And, of course, buttons and commands still launch dialog boxes. The ‘toolbars’ are not referred to as such in the
new Microsoft documentation and Microsoft Help. Except – The ‘Quick Access Toolbar’ which appears top left of the
Ribbon, next to the Office button. See Figure 2‑1. The default Quick Access Toolbar buttons are Save (floppy disk icon),
Undo and Redo. This Quick Access Toolbar is fully customisable and can be placed elsewhere around the top of the
screen, as preferred by the user.
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Figure 2‑23: The Office button, displaying the Microsoft Office logo, is next to the Quick Access Toolbar

The concept on which the new release of Microsoft Office rest is that all users should (should) be able to see the command
or option they want. And if they can’t, by logical clicking around they will come across it quite rapidly. The screen is
more logical, the commands and options altogether more visual, and the environment truly user friendly. It’s tuned to
the wandering eye and the wandering mouse. The point is that you do not need to know or learn where commands are
on certain menus. To a great extent this is achieved in this version, mainly because the way of working and navigating is
in tune with web page browsing which we all do.
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What you see on the screen is a ‘Ribbon’. And the default is the Home Ribbon. More about that later. Above the ribbon
are a number of key words that launch other ribbons (or ‘toolbars’) that fill up the top section off the screen. Each Ribbon
contains several sections, often named ‘tabs’.
In Figure B‑2, on show is the Microsoft Word Home Ribbon. Note the other ribbons available – Insert, Page Layout,
references, etc. Also note the available tabs – Clipboard, Font, Paragraph, etc.

Figure B‑24: The Home Ribbon

Surprisingly, given the dramatic change of the workspace environment, if you are an experienced Office user you will find
it remarkable easy to find the new commands and apply skills and knowledge you already have. If you are a new user,
welcome to the easiest to use version yet, and – by far, the easiest on the eye and brain!

Compatibility
The background coding or structure of the programs has changed as well. So there are compatibility issues that crop up
all the time. This is very important if you will be sharing files with people not on version 2007. In version 2003 Microsoft
Word documents created there, in the .doc format, were compatible with all versions of Office from v97, through 2000
and 2002, to v2003. But in v2007 the default Word file format is .docx, which is not readable in earlier versions. You may
have to save additional versions or save to an earlier one (e.g. v97 – v2003 format) if you want your document to be read
by most Office users. That said, v2007 is expected to receive a very broad take-up. Much greater than v2003. Within a
year you might find the .docx format quite widely used.

At a Glance Highlights Across the Suite
•

Microsoft Office Access 2007 (the database program)

The new version supports PDF and XPS support. This is quite important. With Office Access 2007 you can save a report
as a Portable Document Format file (PDF) or in XML Paper Specification (XPS) format for printing, posting, and e-mail
distribution. By saving your report as a PDF or XPS file, you can capture report information in a form that retains all of
your formatting characteristics yet does not require others to have Access 2007 to print or review your report.
•

Microsoft Office Excel 2007 (the spreadsheet program)

Create professional-looking charts more easily with a completely redesigned charting engine. Apply rich visual
enhancements to your chart, such as 3-D, soft shadowing, and transparency. Create and interact with charts the same
way, regardless of the application you are using, because the Office Excel 2007 charting engine is consistent in Microsoft
Office Word 2007 and Microsoft Office PowerPoint 2007.

Download free eBooks at bookboon.com

94

Outlook 2007: Part II
•

Appendix C

Microsoft Office Groove 2007 (a collaboration software program)

When you create a Groove ‘workspace’, everyone can share information and work together. You can participate by posting
messages and responses, sharing files, and tracking projects and meetings on your shared space. There are three kinds
of workspaces:
1. File sharing, which is a workspace for synchronizing a selected Windows folder across computers.
2. Standard workspace, which is a workspace with a Files tool and a Discussions tool.
3. Template workspace, which offers a workspace with tools you select from a list, such as Calendar, where you
can mark important dates and build collaborative schedules with workspace members; Sketchpad (where
you can use drawing tools); and even Chess Game.
•

Microsoft Office InfoPath 2007 (an application for creating forms that teams and organizations can use
to gather and share information)

Gather information using Microsoft Office Outlook 2007 e-mail messages. With Office InfoPath 2007, you can complete
forms without leaving the familiar Office Outlook 2007 environment, helping you complete your forms quickly and
efficiently.
•

Microsoft Office OneNote 2007 (a flexible program that provides people one place to gather virtually
any type of information — written, doodled, or typed)

Two-way, automatic task synchronization with 2003 and 2007 versions of Outlook, which lets you keep your busy life
well ordered and highly productive.
•

Office Outlook 2007 (e-mail, calendars, and contacts)

RSS! You can now fully subscribe to and interact with Really Simple Syndication (RSS) feeds right from Office Outlook
2007, the most natural place to manage this kind of information. No more hunting around for just the right kind of client
to get your RSS content. Get your daily dose of news along with your daily dose of e-mail.
•

Office PowerPoint 2007 (the presentation program)

Dramatically modify shapes, text, and graphics with new tools and effects. You can now manipulate and work with your
text, tables, charts, and other presentation elements in much richer ways than ever before. Office PowerPoint 2007 makes
these tools readily available through the streamlined user interface and contextual tabs, so that in just a few clicks, you
can add impact to your work.
•

Microsoft Office Project 2007 (the complete collection of planning products that helps you keep track
of the various schedules of the people, places, and things you deal with on a daily, weekly, monthly, or
project basis)

There are a couple of important new features:
1) You can use Top-Down Budgeting to define a budget at a high level (entire program or project) so the
project manager can allocate funds and track costs against the budget, and…
2) Planned and actual costs can be assigned to a task with Cost Resources, which also supports integration
of Project with accounting systems. Both these items make dealing with costs and accounting a whole lot
simpler.
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Microsoft Office Publisher 2007 (business publishing and marketing materials desktop print and Web
publishing application)

The addition of PDF capability. You can now save Office Publisher 2007 files in a fixed file format, such as Portable
Document Format file (PDF) or XML Paper Specification (XPS), for easy sharing. PDF settings within Office Publisher
2007 include options for online viewing, desktop printing, and commercial press-ready printing.
•

Microsoft Office Visio 2007 (a diagramming and data visualization program)

Connect shapes without drawing connectors. New connector functionality in Office Visio 2007 connects shapes, distributes
them evenly, and aligns them for you — with only one click. When you move the connected shapes, they stay connected
and the connectors automatically reroute between the shapes.
•

Microsoft Office Word 2007

In a phrase: Building Blocks. This new feature is a way to add frequently used content to your documents. Select from
a predefined gallery of cover pages, pull quotes, headers, and footers to make your documents look more professional.
You can even create your own Building Blocks to simplify the addition of custom text, like legal disclaimer text or other
frequently used materials.
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New Visual and navigational Features
The Office Button

Figure B‑25: The Office Button (once clicked) shown here in Microsoft Word.

The Office 2007 button, located on the top-left of the window, replaces the File menu and provides access to functionality
common across all Office applications, including but not limited to Opening, Saving, Printing, and Sharing a file. Users
can also choose color schemes for the interface.

Ribbon
The Ribbon, a panel that houses the command buttons and icons, organizes commands as a set of Tabs, each grouping
relevant commands. Each application has a different set of tabs which expose the functionality that application offers.
For example, while Excel has a tab for the Graphing capabilities, Word does not feature the same; instead it has tabs to
control the formatting of a text document. Within each tab, various related options may be grouped together. The Ribbon
is designed to make the features of the application more discoverable and accessible with fewer mouse clicks as compared
to the menu-based UI used until Office 2007.

Contextual Tabs
Some tabs, called Contextual Tabs, appear only when certain objects are selected. Contextual Tabs expose functionality
specific only to the object with focus. For example, selecting a picture brings up the Pictures tab, which presents options
for dealing with the picture. Similarly, focusing on a table exposes table-related options in a specific tab. Contextual tabs
remain hidden when the object it works on are not selected.
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Live Preview
Microsoft Office 2007 also introduces a feature called “Live Preview”, which temporarily applies formatting on the focused
text or object, when any formatting button is moused-over. The temporary formatting is removed when the mouse pointer
is moved from the button. This allows users to have a preview of how the option would affect the appearance of the object,
without actually applying it.

Mini Toolbar
The new “Mini Toolbar” is a type of context menu that is automatically shown (by default) when text is selected. The
purpose of this feature is to provide easy access to the most-used formatting commands without requiring a right-mousebutton click as was necessary in older versions of the software. Since the Mini Toolbar is automatically shown, it remains
semi-transparent until the mouse pointer is situated on the control, in order to allow an almost-unobstructed view of
what is beneath it. It also appears above the right-click menu when a user right-clicks on a selection of words.

Other UI features
Super-tooltips, that can house formatted text as well as images, are used to provide detailed descriptions of what most
buttons do.
The Quick Access toolbar, which sits in the title bar, serves as a repository of most used functions, regardless of which
application is being used, such as save, undo/redo and print.
Zoom slider present in the bottom-right corner, allowing for dynamic and rapid magnification of documents

SmartArt
SmartArt, found under the Insert tab in the ribbon in PowerPoint, Word, Excel, and Outlook, is a new group of easily
editable and formatted diagrams. There are 115 preset SmartArt graphics layout templates (as of Beta 2 Technical Refresh)
in categories such as list, process, cycle, and hierarchy. When an instance of a SmartArt is inserted, a Text Pane appears next
to it to guide the user through entering text in the hierarchical levels. Each SmartArt graphic, based on its design, maps the
text outline, automatically resized for best fit, onto the graphic. There are a number of “quick styles” for each graphic that
apply largely different 3D effects to the graphic, and the graphic’s shapes and text can be formatted through shape styles
and WordArt styles. In addition, SmartArt graphics change their colors, fonts, and effects to match the document’s theme.
Microsoft Word 2007’s help feature recommends SmartArt graphics for organization charts of fewer than 30 shapes that
have 3D effects (such as bevels and glows) applied to them. It suggests Microsoft Visio organization charts for charts of
up to 1000 shapes that must be precisely customizable.
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File formats
Microsoft Office uses a new file format, called Office OpenXML, as the default file format. Word documents (without
macro extensions) are now saved using a .docx extension rather than the traditional .doc extension. Word 2007 can also
save documents in the old format so that they will still be usable in previous versions of Word. In addition, Microsoft has
made available a free add-on that lets older Office editions open documents created under the new 2007 format.
OpenXML is based on XML and uses the ZIP file container. According to Microsoft, documents created in this format are
up to 75% smaller than the same documents saved with previous Microsoft Office file formats, owing to data compression.
Microsoft Office Excel and Microsoft Office PowerPoint also use the new OOXML file formats. Word files containing
macros are saved with the extension .docm.
Microsoft had initially announced that it will support export to Portable Document Format (PDF) in Office 2007.
However, due to legal objections from Adobe Systems, Office 2007 will not have PDF support out of the box, but rather
as a separate free download. Office 2007 documents can also be exported as XPS documents, via another free plug-in
that is also a separate download.
Microsoft backs an open-source effort to support OpenDocument in Office 2007, as well as earlier versions, and also
through a converter add-in for other programs, which works by having third-party programs call a command-line utility.
As of yet, the project only supports conversions between OpenDocument Text and Office Open XML Word documents.

.
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User Assistance System (HELP)
In Microsoft Office 2007, the Office Assistants have been completely removed because of the much improved help system.
One feature of the new help system is the extensive use of Super Tooltips which explains in about one paragraph what
each function performs. Some of them also use diagrams or pictures. These appear and disappear like normal tooltips,
and replace normal tooltips in many areas.

Collaboration features

Figure B‑26: Microsoft Office Groove 2007

Microsoft Office 2007 includes features geared towards collaboration and data sharing. As such, Microsoft Office 2007
features server components for applications such as Excel, which work in conjunction with SharePoint Services, to provide a
collaboration platform. SharePoint works with Microsoft Office SharePoint Server 2007, which is used to host a SharePoint
site, and uses IIS and ASP.NET 2.0. Excel server exposes Excel Services, which allows any worksheet to be created, edited
and maintained via web browsers. it features Excel Web Access, the client-side component which is used to render the
worksheet on a browser, Excel Calculation Service which is the server side component which populates the worksheet
with data and perform calculations, and Excel Web Service that exposes Excel functionalities as individual web services.
Sharepoint can also be used to host Word documents for collaborative editing, by sharing a document. SharePoint can
also be used to hold PowerPoint slides in a Slide Library, from which the slides can be used as a formatting template. It
will also notify users of a slide automatically in case the source slide is modified. Also by using SharePoint, Powerpoint
can manage shared review of presentations. Any SharePoint hosted document can be accessed from the application which
created the document or from other applications such as a browser or Microsoft Office Outlook.
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Microsoft Office 2007 also includes Groove, which brings collaborative features to a peer-to-peer paradigm. Groove can
host documents, including presentations, workbooks and others, created in Microsoft Office 2007 application in a shared
workspace, which can then be used in collaborative editing of documents. Groove can also be used in managing workspace
sessions, including access control of the workspace. To collaborate on one or more documents, a Workspace has to be
created, and then those who are to work on it have to be invited. Any file shared on the workspace are automatically
shared among all participants. The application also provides real-time messaging, including one-to-one as well as group
messaging, and presence features, as well as monitoring workspace activities with alerts, which are raised when predefined set of activities are detected. Groove also provides features for conflict resolution for conflicting edits. Schedules
for a collaboration can also be decided by using a built-in shared calendar, which can also be used to keep track of the
progress of a project. However, the calendar is not compatible with Microsoft Outlook.

Themes and Quick Styles
Microsoft Office 2007 places a huge emphasis on Document Themes and Quick Styles. The Document Theme defines the
colors, fonts and graphic effects for a document. Almost everything that can be inserted into a document is automatically
styled to match the overall document theme creating a consistent document design. The new Office Theme file format
(.THMX) is shared between Word, Excel, PowerPoint and Outlook email messages. Similar themes are also available for
data reports in Access and Project or shapes in Visio.
Quick Styles are galleries with a range of styles based on the current theme. There are quick styles galleries for text, tables,
charts, SmartArt, WordArt and more. The style range goes from simple/light to more graphically/darker.

Application-specific changes
Microsoft Office Word
Blog entries can be authored in Word itself and uploaded directly to a blog. Supported blogging sites include Windows
Live Spaces, WordPress, SharePoint, Blogger, Community Server etc.
New style sheets (quick styles) and ability to switch easily among them.
Word count listed by default in the status bar. The word count dynamically updates as you type.
New contextual spell checker sometimes catches incorrect usage of correctly spelled words, such as in “I think we will
loose this battle”.
Translation tool tip option available for English (U.S.), French (France), and Spanish (International Sort). When selected,
hovering the mouse cursor over a word will display its translation in the particular language. Non-English versions have
different sets of languages. Other languages can be added by using a separate multilingual pack.
Automated generation of citations and bibliographies according to defined style rules, including APA, Chicago, and MLA.
Changing style updates all references automatically. Connect to web services to access online reference databases.

Download free eBooks at bookboon.com

101

Outlook 2007: Part II

Appendix C

Rearchitected native mathematical equation support with TeX-like linear input/edit language or GUI interface. Also
supports the Unicode Plain Text Encoding of Mathematics.
Preset gallery of cover pages with fields for Author, Title, Date, Abstract, etc. Cover pages follow the theme of the document
(found under the Page Layout tab).
Document comparison engine updated to support moves, differences in tables, and also easy to follow tri-pane view of
original document, new document, and differences.
Full screen reading layout that shows two pages at a time with maximal screen usage, plus a few critical tools for reviewing.
Document Inspector which strips Word documents of information such as author name and comments and other “metadata”.
Building Blocks, which lets one save frequently used content, so that they are easily accessible for further use. Building
blocks can have data mapped controls in them to allow for form building or structured document authoring.

Microsoft Office Outlook
•

As a major change in Outlook 2007, Exchange 5.5 support has been dropped. Like Evolution, Outlook
Express and Entourage, Outlook now works only with Exchange 2000 and above.

•

Outlook now indexes (using the Windows Search APIs) the e-mails, contacts, tasks, calendar entries, RSS
feeds and other items, to speed up searches. As such, it features word-wheeled search, which displays results
as characters are being typed in.

•

Search folders, which are saved searches, have been updated to include RSS feeds as well. Search folders can
be created with a specific search criteria, specifying the subject, type and other attributes of the information
being searched. When a search folder is opened, all matching items for the search are automatically retrieved
and grouped up.

•

Outlook now supports text-messages and SMSs, when used in conjunction with Exchange Server 2007
Unified Messaging.

•

Outlook includes a reader for RSS feeds, which used the Windows Common Feeds Store. RSS subscription
URLs can be shared via e-mails. RSS feed updates can also be pushed to a mobile device.

•

Outlook can now support multiple calendars being worked with, simultaneously. It also includes a side-byside view for calendars, where each calendar is displayed in a different tab, and allows easy comparison of
them. Outlook also supports web calendars. Calendars can be shared with other users.

•

Calendar view shows which tasks are due.

•

Flagged e-mails and notes can also be converted to Task items.

•

Outlook includes a To Do Bar, which integrates the calendar, appointments and tasks items, in a concise
view.

•

Online or Offline editing of all Microsoft office 2007 documents via a SharePoint site. All edits are
automatically synchronized.

•

Contacts can be shared among users, via e-mail, Exchange server or a SharePoint site.
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Attachment preview allows users to view Office e-mail attachments in the reading pane rather than having
to open another program.

•

HTML in e-mails is now rendered using the Microsoft Word rendering engine which disallows several
HTML tags like object, script, iframe etc along with several CSS properties.

Microsoft Office Outlook can also include an optional Business Contact Manager which allows management of business
contacts and their sales and marketing activities. Phone calls, e-mails, appointments, notes and other business metrics can
be managed for each contact. It can also keep a track of billable time for each contact on the Outlook Calendar. Based
on these data, a consolidated report view can be generated by Microsoft Office Outlook with Business Contact Manager.
The data can be further analyzed using Microsoft Office Excel. This data can also be shared using SharePoint services.

Microsoft Office Excel
•

Support up to 1,048,576 rows and 16,384 columns in a single worksheet, with 32,767 characters in a single
cell (17,179,869,184 cells in a worksheet, 562,932,773,552,128 characters in a worksheet)

•

Conditional Formatting introduces support for three new features — Color Scales, Icon Sets and Data Bars

•

Color Scales, which automatically color the background of a group of cells with different colors according to
the values.

-- Icon sets, which precede the text in a cell with an icon that represent some aspect of the value of the cell
with respect to other values in a group of cells, can also be applied. Icons can be conditionally applied
to show up only when certain criteria is met, such as a cross showing up on an invalid value, where the
condition for invalidity can be specified by the user.
-- Data Bars show as a gradient bar in the background of a cell the contribution of the cell value in the group.
•

Column titles can optionally show options to control the layout of the column.

•

Multithreaded calculation of formulae, to speed up large calculations, especially on multi-core/multiprocessor systems.

•

User Defined Functions (UDF), which are custom functions written to supplement Excel’s set of built-in
functions, supports the increased number of cells and columns. UDFs now can also be multithreaded. Server
side UDFs are based on the .NET Managed code.

•

Importing data from external sources, such as a database, has been upgraded. Data can also be imported
from formatted tables and reports, which do not have a regular grid structure.

•

Formula Autocomplete, automatically suggests function names, arguments and named ranges, and
automatically completing them if desired, based on the characters entered. Formulae can refer to a table as
well.

•

CUBE functions which allow importing data, including set aggregated data, from data analysis services, such
as SQL Server Analysis Services.

•

Page Layout view, to author spreadsheets in a way that mirrors the formatting that will be applied when
printed.

•

PivotTables, which are used to create analysis reports out of sets of data, can now support hierarchical
data by displaying a row in the table with a “+” icon, which, when clicked, shows more rows regarding it,
which can also be hierarchical. PivotTables can also be sorted and filtered independently, and conditional
formatting used to highlight trends in the data.
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Filters, now includes a Quick filter option allowing the selection of multiple items from a drop down list of
items in the column. The option to filter based on color has been added to the choices available.

•

Excel features a new charting engine, which supports advanced formatting, including 3D rendering,
transparencies and shadows. Chart layouts can also be customized to highlight various trends in the data.

Microsoft Office PowerPoint
•

Improvements to text rendering to support text based graphics.

•

Rendering of 3D graphics.

•

Support for many more sound file formats such as .mp3 and .wma.

•

Support for tables and enhanced support for table pasting from Excel.

•

Slide Library, which lets you reuse any slide or presentation as a template. Any presentation or slide can be
published to the Slide Library.

•

Any custom-designed slide library can be saved.

•

Presentations can be digitally signed.

•

Improved Presenter View.

•

Added support for Widescreen Slides.

•

Allows addition of custom placeholders.
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Microsoft Office OneNote
•

OneNote now supports multiple notebooks.

•

Notebooks can be shared across multiple computers. Anyone can edit even while not connected and changes
are merged automatically across machines when a connection is made. Changes are labeled with author and
change time/date.

•

Notebook templates.

•

Word-wheeled search is also present in OneNote, which also indexes notes.

•

Synchronization of Tasks with Outlook 2007. Also Outlook can send mails to OneNote, or open pages in
OneNote that are linked to tasks, contacts, appointments/meetings.

•

Support for tables. Using tabs to create tabular structure automatically converts it to a table.

•

OCR is performed on images (screen clips, photos, scans) so that any text in them is searchable.

•

Audio and video recordings are also tagged and indexed, so that they can be searched.

•

Notes can have hyperlinks among themselves, or from outside OneNote to a specific point on a page.

•

Embedding documents in notes.

•

Extensibility support for add-ins.

•

Drawing tools for creating diagrams in OneNote.

•

Typing any arithmetic expression, followed by “=” results in the result of the calculation being displayed.

•

Send to Microsoft OneNote, via which any application can print to a virtual printer for OneNote and the
“printed” document is imported to the notebook, and any text is indexed for searching.

•

OneNote Mobile is included for Smartphones and some PocketPC devices. Syncs notes two-way with
OneNote. Takes text, voice, and photo notes.

Microsoft Office Access
•

Access now includes support for a broader range of data types, including documents and images.

•

Referential integrity checks. If any information is entered which doesn’t have a related entry in another
table, Access offers to either remove the entry or update the other table. (Note: This feature has existed since
Access 2.0)

•

Whenever any table is updated, all reports referencing the table are also updated.

•

Dropdown lists for a table can be modified in place.

•

Lookup Fields, which get their values by “looking up” some value in a table, have been updated to support
multi valued lookups.

•

Many new preset schemata are included.

•

Access can synchronize with Windows SharePoint Services 3.0 and Office SharePoint Server 2007. This
feature enables a user to use Access reports while using a server-based, backed-up, IT managed version of
the data.
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Microsoft Office Publisher
•

Templates automatically fill out with information such as company name, logo etc, wherever applicable.

•

Frequently used content can be stored in Content Store for quick access.

•

A document can be automatically converted from one publication type, such as a newsletter, to another
publication type, say a web page.

•

Save as PDF supports commercial printing quality PDF.

•

Catalog Merge can create publication content automatically by retrieving data, including text, images and
other supported types, from an external data source.

•

Design Checker, which is used to find design inconsistencies, has been updated.

Microsoft Office InfoPath
•

InfoPath designed forms can now be used from a browser.

•

A form can be sent out to people via e-mail. Such forms can be filled out from Outlook 2007 itself.

•

Automatic conversion of forms in Word and Excel to InfoPath forms. Forms can also be exported to Excel.

•

Forms can be published to a network share or to SharePoint server.

•

Adding data validation, using validation formulae, and conditional formatting features without manually
writing code.

•

Print Layout view for designing forms in a view that mirror the printed layout. Such forms can be opened
using Word as well.

•

Ability to use Microsoft SQL Server, Microsoft Office Access, or other databases as back-end data repository.

•

Multiple views for the same forms, to expose different features to different class of users.

•

Template Parts, used to group Office InfoPath controls for use later. Template parts retain its XML schema.

Microsoft Office Visio
•

PivotDiagrams, which are used to visualize data, show data groups and hierarchichal relationships.

•

Visual modification of PivotDiagrams by dragging data around levels, to restructure the data relationships.

•

PivotDiagrams can show aggregate statistical summaries for the data and show them.

•

Shapes can be linked with external data sources. Doing so, the shapes are formatted according to the data.
The data, and hence the shapes, are updated periodically. Such shapes can also be formatted manually using
the Data Graphics feature.

•

AutoConnect : Link easily two shapes.

•

Data Link : Link data to shapes.

•

Data Graphics : Dynamic objects (text and images) linked with external data.

•

New Theme behaviour and new shapes.

Microsoft Office Project
•

Ability to create custom templates.

•

Any change in the project plan or schedule highlights everything else that is affected.

•

Analyze changes without actually committing them. Changes can also be done and undone
programmatically, to automate analysis of different changes.
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•

Improved cost resource management and analysis for projects.

•

Project data can be used to automatically create charts and diagrams in Microsoft Office Excel and Microsoft
Office Visio, respectively.

•

The project schedule can be managed as 3D Gantt chart.

•

Sharing project data with the help of SharePoint services.

Microsoft SharePoint Designer
•

Microsoft Office SharePoint Designer 2007 is new addition to the Office suite replacing discontinued
FrontPage for users of SharePoint. People who don’t use SharePoint can use Microsoft Expression Web.

•

Supports features and constructs that expose SharePoint functionality.

•

Supports ASP.NET 2.0 and Windows Workflow Foundation.

•

Support for creating workflows and data reports, from external data sources.

•

Allows XML data to be displayed using XSLT

General Keyboard Navigational Tips in Office 2007
You will perhaps know by now about the Microsoft Office Button

. This button is at the top left of the window

(where the File menu was in previous versions of Office), and you can get there by using Key Tips, the TAB key, or
arrow keys. There are Key Tip badges (and also underscored letters) in the menu to show you which letters to press to
use a command, just as there were on menus in previous versions of Office. For more details on Key Tips within specific
applications refer to the course manual or Appendix as necessary. But in Office applications in general, you may find the
following information useful.
Here is a brief list of keystrokes you need for moving around office applications, if using the keyboard shortcuts is what
you like to do.
•

Use the TAB key and arrow keys to navigate a dialog box.

•

Activate a command by pressing ENTER. In some cases, this opens a gallery or menu so you can choose
what you want and then activate it by pressing ENTER again. For some commands, like the Font box,
pressing ENTER puts the focus in the box so you can start typing, or use the arrow keys to scroll through
lists. Once you’ve got what you want, press ENTER again.

•

CTRL+TAB cycles through the tabs in a dialog box.

•

SPACEBAR selects and clears check boxes.

•

SHIFT+F10 opens the shortcut menu, which opens when you right-click an item.

•

ESC closes an open dialog box or shortcut menu. If nothing is open, it takes the focus away from the Ribbon
and back to the main document.

•

To close a task pane, first press CTRL+SPACEBAR to open the task pane menu. Then press C to select Close
on the menu.

•

ALT+F4 (pressed simultaneously) closes the active window.

•

F1 opens the Help window.
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Beyond Office 2007
The next version or release of Microsoft Office
This is an important subject given that there are so many people who, at every new release of a version of Office, are
unsure whether to get the new release or wait for the next one. For various reasons, many people and certainly many
many organizations and companies skip a lot of new releases and choose the best time to ‘migrate’ to a new or current
version/release.
Microsoft Office 14 is the working title for the next version of the Microsoft Office System productivity suite for
Microsoft Windows. It entered development during 2006 while Microsoft was finishing work on Microsoft Office 12,
which was released as the 2007 Microsoft Office System. The major version number 13 has been skipped presumably due
to triskaidekaphobia (fear of or aversion to the number 13). presently, it is expected that Office 14 will ship in the first
half of 2009 though this date has neither been confirmed nor denied by Microsoft.
According to an article published in InfoWorld in April 2006, Office 14 will be more ‘role-based’ than previous versions.
The article cites Simon Witts, corporate vice president for Microsoft’s Enterprise and Partner Group, as claiming that
there would be features tailored to employees in “roles such as research and development professionals, sales persons, and
human resources.” Borrowing from ideas termed ‘Web 2.0’ when implemented on the Internet, it is likely that Microsoft
will incorporate features of SharePoint Server in Office 14.
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